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Preface

Welcome to the AMIS User's Guide.  This guide shows you how to access the 
Aviation Management Information System (AMIS), version 4.3. 

The Contents at the front of this guide help you find topics easily.  Each 
chapter explains specific topics and tasks you must understand to effectively 
use AMIS. The appendices that are located in the back contain additional 
helpful information.

We hope you find this guide friendly and easy-to-use.  If you have any 
questions, comments, or concerns, please contact:

USDA Forest Service
National Fire and Aviation Management 
Information Systems Team
3833 S. Development Avenue
Boise, ID  83705-5354

1-800-253-5559

You can email us at:

fire_help@dms.nwcg.gov

Windows 95, Windows 98, and Windows NT are registered trademarks of Microsoft Corporation.  This guide employs many 
styles, conventions, and guidelines established in the “Microsoft Manual of Style for Technical Publications.”
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Chapter 1.  About this guide

This guide describes the Aviation Management Information System (AMIS), 
version 4.3.  It contains information about how to enter and update aviation 
contracts and invoices, as well as how to enter new and activate existing 
aircraft information, enter and update vendor and pilot information, and how 
to generate a variety of AMIS reports.

Before you begin
Before using the AMIS software, you must feel confidant that:

• You are familiar with your personal computer and function keys and 
understand personal computer concepts.

• You are familiar with using the US Forest Service IBM hardware and 
software platform and can perform basic Windows 95 functions.

• You are familiar with fire reporting terminology and fire information 
concepts.

How to use this guide
Each chapter explains a specific functional area of the AMIS system.  Chapter 
titles are shown at the top of each page.  At the beginning of each chapter you 
will find a chapter overview and a picture and related field descriptions of 
every form discussed within the chapter.

Chapter 1, “About this guide,” introduces the AMIS User’s Guide and 
explains how to use it.

Chapter 2, “Getting started,” explains some of the basic information you need 
to begin using AMIS.  It introduces access roles, basic navigation skills and 
local limits.

Chapter 3, “AMIS Forms Entry,” explains how to access and manipulate 
contract, aircraft, vendor, and pilot information and how to complete Flight 
Use Reports (122s).

Chapter 4, “AMIS Reports,” explains how to retrieve information from the 
database and generate an AMIS report that you can view, mail, and print from 
your personal computer.

Appendix A, “Function keys,” lists AMIS function key combinations.

Appendix B, “Pay codes and invoices,” identifies the pay codes used to 
complete an invoice and how to describe flight time and availability.

The Glossary lists terms and definitions used in this guide.
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Conventions
The following conventions are used within this guide:

• Menu options and field names appear in bold, in the same case as on your 
screen or keyboard.  Hard label keys appear in small capital letters.  For 
example, a step in a procedure might instruct you to

1 In the Contract Number field, type the desired contract number and 
press TAB or ENTER.

• A plus sign (+) between hard label keys, such as SHIFT + TAB, means to 
press and hold the first key, and then press the second key.

• AMIS menu names, form names, and field names appear in the same case 
as shown on the screen.  For example, step 4 in a task might instruct you 
to

4 Click OK twice to return to the AIRCRAFT INFORMATION 
form, and then click Save.

• Topics of special interest or hints that will help you perform a specific 
task show a line before and after the text.  The text appears in italic type.  
For example:

To edit aircraft information the aircraft status must be ACTIVE.

How to obtain a copy of this guide
The current version of this guide is available on the US Forest Service site on 
the World Wide Web.  You can print the entire guide or individual chapters.

To print the current version or selected chapters of the AMIS 
User's Guide

1 Log on to your Internet Service Provider.

2 Type www.fs.fed.us/fire/planning/nist in the Address bar, and then 
press ENTER.

3 Scroll down to the bottom of the page, then click Distribution.

4 Click AMIS User's Guide, then follow the instructions on your screen.
1.2 version 4.3 October 27, 2000
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Chapter 2.  Getting started

This chapter outlines some of the basic information you need to begin using 
AMIS.  It outlines basic concepts and functions you can perform based on 
your assigned access role.  By reviewing and understanding this chapter you 
will have a smoother flight through the AMIS system.  Topics include:

• What’s new in AMIS 4.3
• Navigating through the AMIS system
• Transmitting your data to NITC.

What’s new in AMIS 4.3
AMIS version 4.3 is a PC Client/Server software application.  When you save 
your AMIS data, it is saved in the Oracle database on your local network 
server. The data is then loaded into the National Fire Management Integrated 
Database (NIFMID), the database for fire occurrence data, at the National 
Interagency Technology Center (NITC).
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Although AMIS 4.3 has a similar look and feel of AMIS 3.0, AMIS 4.3 allows 
you to use your mouse to select menu options in a Windows operating 
environment.  In addition, AMIS 4.3 is Year 2000 compliant.

AMIS allows you to:

• enter and store aircraft use information
• report aircraft use information to the United States Department of 

Agriculture (USDA)
• create and retrieve reports for Regional and Forest offices
• meet upward reporting requirements.

To obtain user support

• Contact your local Regional support group.  To locate this group, check 
with your supervisor and/or computer specialist.

Your Regional support group may also contact the AMIS support
 staff at 1-800-253-5559 or email us at:  

fire_help@dms.nwcg.gov

To start AMIS 4.3

1 On the Start menu, click Programs, point to F&AM Applications, and 
then click AMIS.

2 In the Logon dialog box, type your Username, your Password, and 
Database name, and then click Connect or press ENTER.

The following diagram shows the Logon dialog box that displays when you 
first log on to AMIS.

Your Username, Password, and Database name are case-sensitive.  Be sure 
to enter this information using the appropriate uppercase and lowercase 
letters.

If you are having trouble logging on or do not know your Username, 
Password, or Database name, contact your local Regional support group.
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The following diagram shows the WELCOME TO AMIS screen.  The Data 
Entry Location for this example is “Region 02 - Rocky Mountain Region.”

To set up or change your Data Entry Location

1 Delete the current entry in the Data Entry Location text box, and then 
click List.

2 Select the Data Entry Location of your choice, click OK, and then click 
Save.

The following diagram shows the index that displays for Data Entry Location.

To log off AMIS

1 From any form, click Exit on the File menu, or click Close.

2 Click Exit on the WELCOME TO AMIS screen.
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Navigating through the AMIS system
The following diagram outlines some of the elements as they appear on the 
AMIS initial screen.  These terms will be used throughout this AMIS User’s 
Guide.

AMIS access roles

You have one AMIS access role assigned to your Oracle user ID.  An access 
role allows you to see and perform specific AMIS functions on the AMIS 
menu.  These three access roles include:

• Manager.  Access to all modules, including Role Administration.
• Contract.  Access to aircraft, contract, and vendor modules.
• Invoice.  Access to flight invoice modules.

Using AMIS menus

Each AMIS menu contains one or more menu options or commands that 
allow you to display specific AMIS forms or perform a specific function.  You 
can select a menu option or command whenever the AMIS menu bar is 
displayed.

When a menu option appears dimmed, it is unavailable to your access role.  
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Action menu

The Action menu allows you to perform the following functions:

• change your password
• if authorized, assign access roles.

Contract menu

The Contract menu allows you to perform the following functions:

• access the AIRCRAFT CONTRACTS form
• access the AIRCRAFT INFORMATION form
• access the VENDOR INFORMATION form
• add a new pilot to your site-specific list.

Invoice menu

The Invoice menu allows you to access the FLIGHT USE REPORT form.
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Reports menu

The Reports menu allows you to perform the following functions:

• generate AMIS Invoice Reports
• generate AMIS Contract Reports
• generate AMIS Miscellaneous Reports.

For more information about AMIS National Reports, see “Working with AMIS 
National Reports” in Chapter 4, “AMIS Reports.”

Help menu

The Help menu allows you to perform the following functions:

• show available function keys
• display informational error messages
• find out more about this version of AMIS.

Window menu

The Window menu displays standard Windows-based options.
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Displaying function keys

Function keys allow you to perform many common tasks quickly and easily.  
When you select Show Keys, you can display every function key combination 
currently available for your use.

Show keys is function and menu-specific.  Only the active function keys 
display on the Keys list. 

To show active function keys

• On the Help menu, click Show Keys, or press CTRL + F1.

The following diagram shows the Show Keys window as it appears while 
displaying the FLIGHT USE REPORT.

Displaying an index or list of values

In AMIS, an index identifies the possible values for any field in a form that 
has a defined set of entries.  By displaying the index, you can choose from the 
list of values and save typing time.

An index is available for a specific field when <List> displays on the status 
bar.  

To display the index for a specific field on a form

1 TAB or ENTER to the field of your choice.

2 If <List> displays on the status bar, press F9.

3 Select the field value of your choice, then click OK to exit the index and 
return to the form.
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The following index displays the INVOICE NUMBERS list for the FLIGHT 
USE REPORT.

Searching for a specific index entry

The percent sign (%) is a wildcard that allows you to narrow your search 
when you are unsure of the exact value or if the index contains a long list of 
available values.  

To search for specific characters within an index of available 
values

1 TAB or ENTER to the field of your choice.

2 If <List> displays on the status bar, press F9.

3 In the Find box, type the first one or two characters of the index entry of 
your choice, type % (the percent sign), and then click Find.

4 Select the field value of your choice, then click OK to exit the index and 
return to the form.

The following diagram shows a search for all aircraft Registration Numbers  
that begin with the letter “N.”
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To display available error information for a completed field

1 Click in the field of your choice and then press SHIFT + F1.

2 To exit the help screen and return to the current AMIS form or menu, 
click OK.

If you are unable to solve the problem using AMIS help information, contact 
your local AMIS system administrator.

Transmitting your data to NITC
Currently, AMIS 4.3 does not allow you as an individual to transmit your 
AMIS datafile to the National Interagency Fire Management Integrated 
Database (NIFMID).  Your local Regional support group will be notified 
when this function is available.  In the interim, you must contact Milford 
Suida, who will then transmit your AMIS data the NITC.

To transmit your AMIS data to NITC

• Contact Milford Suida at 520-527-3554 

or send him an email message at

msuida@fs.fed.us

Before contacting Milford, be sure that your AMIS data for the reporting period  
is complete and accurate.  You will receive notification when your AMIS data 
was successfully loaded into NIFMID.
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This chapter outlines the information you need to access and manipulate 
contract, aircraft, vendor, and pilot information and how to complete Flight 
Use Reports.  

• Contracts explains how to access the AIRCRAFT CONTRACTS form, 
how to enter new contract information, how to edit and delete a contract, 
and how to delete a Registration Number from a Contract.  This section 
also explains Pay Codes and how to work with WCF equipment.

• Aircraft explains how to access the AIRCRAFT INFORMATION form, 
how to include (activate) and exclude (deactivate) aircraft from the 
National distributed aircraft list to your site-specific aircraft table, and 
how to edit and aircraft information on your site-specific list.

• Vendors explains how to access the Add/Modify Aircraft Vendors form, 
how to enter new vendor information, and how to edit or delete vendor 
information.

• Pilot explains how to add a new pilot to your site-specific list.

• Invoices explains how to access the FLIGHT USE REPORT form, how 
to enter Flight Use Reports (FS-6500-122), and how to modify invoice 
information. 

With AMIS 4.3, you can use the AMIS toolbar to access Aircraft, Vendor, and 
Contract forms whenever you need to update information.  For example, to 
update pilot information while displaying the AIRCRAFT CONTRACTS form, 
simply click Pilots on the Contract menu to add new pilot information to your 
site-specific list.

Contracts
Once the contract for aircraft and aircraft services is approved, enter the 
information into the AIRCRAFT CONTRACTS form.  This form allows you 
to enter all the information listed on the contract including contract number, 
vendor, aircraft and aircraft pay code rates assigned to the contract, and 
special equipment for non-WCF aircraft.

Aircraft, vendor, and contract information must be up-to-date before you can 
enter an invoice (FS-6500-122).

To access the AIRCRAFT CONTRACTS form

• On the Contract menu, click Contract.
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AIRCRAFT CONTRACTS form

Field Description and action to be taken

Contract Number Type the contract number, up to 20 characters.
For Forest Service-owned aircraft, type WCF.

Type Type the contract type, up to three characters.  Some valid contract types 
are:

• JC, for job contract 
• L, for lease
• CWN, for call when needed 
• EU, for exclusive use
• POA, for Purchase Order arrangement.

Begin Date Type the beginning month, day, and year as specified in the contract, in 
the format mm/dd/yyyy.
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To complete the AIRCRAFT CONTRACTS form

1 Complete the fields in the form as instructed.  

2 When finished, click Save.

To edit aircraft contract information

1 In the Contract Number field, type the desired contract number and 
press TAB or ENTER.

2 Edit the fields of your choice, and then click Save.

To delete a Registration Number from a contract

1 In the Contract Number field, type the desired contract number and 
press TAB or ENTER.

2 Press TAB and SHIFT + TAB to move the cursor to the Regist No. of your 
choice, click Delete Registration, and then click Save.

You cannot delete a Registration Number from a contract if there is invoice 
data attached to it.

End Date Type the ending month, day, and year as specified in the contract, in the 
format mm/dd/yyyy.

Contracting Unit Type the Forest Service organization unit that originates and/or 
administers the contract, up to 35 characters.

To display a subset of available contracting units, type the USFS Region 
number of the contracting unit, and then click List or press F9.

For contract numbers that begin with “55-024B,” this field is 
automatically set to “1302.”

Vendor Type the name of the vendor, up to 30 characters, or click List or press 
F9 to display a list of vendors.
Enter this field exactly as specified in the contract.

Regist No. For each sequence number, type the FAA registration number for each 
aircraft assigned to this contract, up to six characters.

Edit PC Type Y to change aircraft pay codes and contract rates.  

Edit EQ Type Y to change Special Equipment for non-WCF aircraft.  

Type
(for display only)

This field identifies the aircraft type, as defined in the AIRCRAFT 
INFORMATION form.

Make/Model
(for display only)

This field identifies the aircraft manufacturer and model, as defined in 
the AIRCRAFT INFORMATION form.
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To delete a contract

You must have the appropriate access role to delete a contract.  You cannot 
delete a contract if it is attached to an invoice.

1 In the Contract Number field, type the contract number you want to 
delete, and then press TAB or ENTER.

2 Verify that the desired contract displays on the screen.

3 To delete the contract, click Delete Contract, and then click Yes on the 
Forms information dialog box to confirm the delete.

The following diagram shows the Forms information dialog box. 

Pay Codes

A Pay Code is a two-character code that best describes the purpose of an 
aircraft’s billing charges.  Every Pay Code is associated with a specific rate, as 
contracted with a particular vendor and aircraft.  For example, one vendor 
may contract their flight time (Pay Code FT) for $230.00 per hour (Contract 
Rate).  An airtanker billing for overnight charges (Pay Code ON) may be 
contracted at a rate of $60.00 per night (Contract Rate).

The Pay Rate dialog box displays either when you:

• create a new aircraft contract
• type Y in the Edit PC field.

To enter Pay Codes and Contract Rates

Do not type the dollar sign ($) when entering Contract Rates.

1 In the Pay Code field, type the pay code as specified in the contract, and 
then press TAB or ENTER.

2 In the Contract Rate field, type the contract rate for that pay code as 
specified in the contract, and then press TAB or ENTER.

3 Type all Pay Codes and Contract Rates for the aircraft, and then click 
Save.
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The following diagram shows the Pay Rate dialog box.

To change Pay Codes to an existing aircraft contract

1 In the Contract Number field, type the desired contract number and 
press TAB or ENTER.

2 Press TAB and SHIFT + TAB to move the cursor to the Edit PC field, type 
Y and then press TAB or ENTER.

3 Change the appropriate Pay Codes and Contract Rates as needed, and 
then click Save.

Editing special equipment for non-WCF aircraft

Vendors that contract with the Forest Service may install special equipment 
on their aircraft.  When special equipment is specified for non-WCF aircraft, 
enter the special equipment using the AIRCRAFT CONTRACTS form.

To specify and/or edit special equipment for WCF equipment, you must 
access the AIRCRAFT INFORMATION form.  For more information, see 
“Special equipment for WCF aircraft,” earlier in this chapter.

To edit special equipment for non-WCF aircraft

1 In the Contract Number field, type the desired contract number and 
press TAB or ENTER.

2 Press TAB and SHIFT + TAB to move the cursor to the Edit EQ field, type 
Y and then press TAB or ENTER.

3 Click List to display a list of special equipment.
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4 Select all the special equipment that applies to the aircraft, then click 
Save.

The following diagram shows the Special Equipment dialog box.

Aircraft
When you access the AIRCRAFT INFORMATION form for the very first 
time and list available aircraft, AMIS retrieves every aircraft registration 
number defined Nationally during the last three years.  At this time, every 
aircraft has an “inactive” status.  When you change an aircraft’s status to 
“active” it is added to your site-specific list.  Later, when you list available 
aircraft to complete an invoice or other form, only those aircraft that have an 
active status for your site will display.

To access the AIRCRAFT INFORMATION form

• On the Contract menu, click Aircraft.
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AIRCRAFT INFORMATION form

Field Description and action to be taken

Registration No.
(required)

Type the FAA aircraft registration number, including all characters and 
numbers.

The aircraft registration number must begin with the alphabetic 
designation of country or registration.  For example:

• N, designates the United States
• C, designates Canada
• M, designates Mexico.

ACTIVE Type Y or N to include this aircraft in your site-specific listing.
For new aircraft, the default is “Y.”

Aircraft Type
(required)

Type the aircraft type code that identifies the aircraft type, up to two 
characters.  Valid aircraft type codes are:

• H, for helicopter
• T, for airtanker
• F, for all other fixed-wing aircraft.
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To complete the AIRCRAFT INFORMATION form

You must have the Manager access role to add new aircraft registration 
numbers.

1 Complete the fields in the form as instructed.

2 For WCF aircraft, click List, select all special equipment that applies to 
the aircraft, and then click Save.

3 To save the new aircraft information, click Save.

For more information about completing the WCF Special Equipment form, see 
“Special equipment for WCF aircraft,” later in this chapter.

To include (activate) aircraft in your site-specific listing

1 In the Registration No. field, type the six-digit FAA aircraft registration 
number, and then press TAB or ENTER.

2 In the ACTIVE field, type Y, and then click Save.

To exclude (deactivate) aircraft from your site-specific listing

1 In the Registration No. field, type the six-digit FAA aircraft registration 
number, and then press TAB or ENTER.

2 Press ENTER until the ACTIVE field is highlighted, type N, and then 
click Save.

Manufacturer
(required)

Type the aircraft manufacturer, up to 20 characters.

Aircraft Model
(required)

Type the aircraft model, up to 25 characters.

Fuel Consumption
(for display only)

This field identifies the rate of fuel consumed per hour, based on the 
aircraft manufacturer's engine specification and FAA guidelines, up to 
four characters.

IFR Capable
(required)

Type the one-character code to identify whether the aircraft is IFR 
capable.

• Y identifies the aircraft as being IFR capable
• N identifies the aircraft as not being IFR capable.

Passenger Seats Mfg.
(for display only)

This field identifies the number of passenger seats the aircraft contained 
when it was shipped from the aircraft's manufacturer, up to three 
numbers.

Passenger Seats Normal
(required)

Type the number of seats available for passenger seating, up to three 
numbers.
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To edit aircraft information

To edit aircraft information the aircraft status must be ACTIVE.

1 In the Registration No. field, type the six-digit FAA aircraft registration 
number, and then press TAB or ENTER.

2 Edit the fields in the form as instructed.

3 For WCF aircraft, select all special equipment that applies to the aircraft, 
and then click Save.

4 Click OK twice to return to the AIRCRAFT INFORMATION form, and 
then click Save.

To delete an aircraft from your server’s database

1 In the Registration No. field, type the six-digit FAA aircraft registration 
number, and then press TAB or ENTER.

2 Verify that the desired aircraft displays on the screen.

3 Click Delete, and then click Yes on the Forms information dialog box to 
confirm the delete.

Special equipment for WCF aircraft

The Special Equipment button automatically displays on the AIRCRAFT 
INFORMATION form for Forest Service-owned (WCF) aircraft.  This button 
allows you to specify the equipment that is installed on the WCF aircraft, 
including such items as a fertilizer spreader, dip tanks and water pumps, or 
other fire suppression equipment.

To edit special equipment for non-WCF aircraft, you must access the 
AIRCRAFT CONTRACTS form.  For more information, see “Editing special 
equipment for non-WCF aircraft,” earlier in this chapter.

To specify special equipment for WCF aircraft

1 In the Registration No. field, type the six-digit FAA aircraft registration 
number, and then press TAB or ENTER.

2 Click Special Equipment, and then use the up and down arrow keys to 
position the cursor in the text box next to the special equipment that 
applies to the aircraft.

3 To select that special equipment, press ENTER.

4 Select all special equipment that applies to the aircraft, and then click 
Save.

5 Click OK twice to return to the AIRCRAFT INFORMATION form, and 
then click Save.
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The following diagram shows the WCF Special Equipment dialog box that 
displays when you update special equipment.

The following diagram shows the Forms dialog box that displays when you 
update special equipment.

The following diagram shows the Forms dialog box that displays the 
transaction is complete.
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Vendors
Vendors contract with the Forest Service to supply aircraft and related 
services.  If the vendor name does not already exist in the database when the 
contract is approved, you must enter it into AMIS before you can complete 
the AIRCRAFT CONTRACTS form.

Every vendor used in the last three years is stored in the database.

To access the Add/Modify Aircraft Vendors form

• On the Contract menu, click Vendor.

Add/Modify Aircraft Vendors form

Field Description and action to be taken

Name
(required)

Type the name of the vendor, up to 30 characters.
This field must be entered exactly as it appears in the contract.  For 
Forest Service-owned aircraft, type USDA FS.

Address
(required)

Type the street address of the vendor as specified in the contract, up to 25 
characters.
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To complete the Add/Modify Aircraft Vendors form

• Complete the fields in the form as instructed, and then click Save.

To edit vendor information

1 In the Name field, type the vendor name, and then press TAB or ENTER.

2 Edit the fields in the form as instructed, click Save, and then click OK on 
the Forms information dialog box.

To delete a vendor

You must have the appropriate access role to delete a vendor.  You cannot 
delete a vendor if it is attached to a contract and/or an invoice.

1 In the Name field, type the vendor name, and then press TAB or ENTER.

2 Verify that the desired vendor displays on the screen.

3 To delete the vendor, click Delete, and then click OK on the Forms 
information dialog box.

City
(required)

Type the city of the vendor’s address as specified in the contract, up to 
20 characters.

St
(required)

Type the two-character standard postal service state abbreviation of the 
vendor’s address as specified in the contract.

Zip+4
(required)

Type the five digit or zip+4 zip code of the vendor’s address as specified 
in the contract, up to 10 characters.

Phone
(optional)

Type the vendor's telephone number, in the format
(area code) 123-4567, up to 14 characters.
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Pilots
The Aircraft Pilots form allows you to add, search for, change, or delete pilot 
names on your site-specific list.

To access the Aircraft Pilots form

• On the Contract menu, click Pilot.

Aircraft Pilots form

To Do this

Enter new pilot information to your site-
specific list

Type the Pilot’s Last Name and press ENTER.  Type the 
First Name, press ENTER, and then click OK to confirm 
your changes.

List all pilot names Click List.

Search for a pilot name Type the first several characters of the pilot’s Last Name, 
and then click List.  Select the pilot of your choice, and then 
click OK. 

Delete pilot information to your site-
specific list

Type the Pilot’s Last Name and press ENTER.  Type the 
First Name, press ENTER, and then click Delete.
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The following screen show a search for pilot Last Names that begin with the 
letters “Arm.”

Invoices
Flight information is manually recorded on Flight Use Report FS-6500-122  
forms.  In AMIS, the FLIGHT USE REPORT form allows you to 
electronically maintain key information from hardcopy FS-6500-122s.

AMIS verifies most contract, vendor, and aircraft information based on the 
information entered on the AIRCRAFT CONTRACTS form.

For more information about aircraft information, see “Aircraft” earlier in this 
chapter.  For more information about vendor information, see the previous 
section “Vendors.”

To access the FLIGHT USE REPORT form

• On the Invoice menu, click Invoice.
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FLIGHT USE REPORT
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Field Description and action to be taken

Invoice Number Type the number of the invoice, the seven to ten-digit number located in 
the upper left-hand corner of form FS-6500-122.

Flight Date Type the month, day, and year of the flight, in the format mm/dd/yyyy.

Contract Number Type the contract number, up to 20 characters.

Vendor Name
(for display only)

This field displays the name of the vendor as specified in the contract.

Supplying Unit
(for display only)

This field displays the Forest Service organization unit that originated 
and/or administers the contract.

Registration Type the registration number using the list of available aircraft 
Registration Numbers.

Aircraft Make/Model
(for display only)

This field displays the aircraft manufacturer and model.

Type
(for display only)

This field displays the aircraft type.

INVOICE TOTAL This field displays the total dollar amount of the invoice.

Leg Type the number of the flight leg.

The default value of the first flight leg is “1.”  Although the flight leg 
number defaults to the next sequential number, you can enter any 
number from 2 to 99.

User Unit Type the two to four-digit Forest Unit code, three-digit agency code, or 
two-digit state code of the unit or agency using the aircraft.

For example, “0210” identifies the Arapahoe and Roosevelt National 
Forests in Region 2.

User Code Type the two-digit code of the administrative unit using this leg of the 
flight.

Flight/Resource Order Type the flight or resource order number assigned to this leg of the flight.

For example, “AZ-TFN-0139” is a valid resource number.

FAA Identifier - From Type the FAA airport code that identifies the starting point of this flight 
leg.

FAA Identifier - To Type to FAA airport code that identifies the ending point of this flight 
leg.

Mission Type the two-digit mission code that best describes the use of the 
aircraft.

Use Mission in conjunction with Pay Code to describe the flight leg.  For 
example, to describe an airtanker on standby, enter 10 in the Mission 
field and SB in the Pay Code field.

Pay Code Type the two-character payment code that best describes the purpose of 
the charges.
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To complete the FLIGHT USE REPORT

1 Complete the fields as instructed.

2 If required, complete the Pilot Details form and Passengers/Cargo/
Retardant form.

3 Click Remarks to add remarks if any.

4 When finished, click Save.

5 Continue entering new FLIGHT USE REPORTS as needed, and then 
click Exit when finished.

For more information about completing Pilot Details and the Passengers/
Cargo/Retardant form, see the next section, “Completing Pilot Details and 
Passengers/Cargo/Retardant forms.” 

To edit an invoice

1 In the Invoice field, type the desired invoice number, and then press TAB 
or ENTER.

2 Edit the fields in the form as instructed, and then click Save.

To clear a line of flight leg information

1 Press TAB to move the cursor to the flight Leg of your choice.

2 Click Delete Leg.

H/C Type one of the following:

• H to identify “Hobbs Meter”
• C to identify “Clock Time”
• leave blank to skip this field and advance to the Elapse Time field.

Clock Time or Hobbs Meter - 
Start

Type the beginning clock time or Hobbs meter reading, in the format 
99999.
Since you are restricted to a 5-character field length and a decimal point 
counts as one character, you must truncate the meter reading to fit. 

For example, suppose the beginning Hobbs meter reading is “7172.11.”  
To enter the starting Hobbs reading to the nearest 10th, type 172.1. To 
enter the starting Hobbs reading to the nearest 100th, type 72.11.

Clock Time or Hobbs Meter - 
Stop

Type the ending clock time or Hobbs meter reading, in the format 99999.

Elapse Time This field displays the calculated elapsed time of the flight leg.
If the Rate field is a daily or flat rate, the Elapse Time field is “1.”

Rate Type the appropriate hourly, daily, or Hobbs meter rate, in the format 
9999.99.

Leg Total
(for display only)

This field displays the calculated total of the Elapse Time multiplied by 
the Rate.
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To delete an invoice

You must have the appropriate access role to delete an invoice.

1 In the Invoice Number field, type the invoice number you want to delete, 
and then press TAB or ENTER.

2 Click Delete Inv.

3 Verify that the desired invoice displays in the DELETE INVOICE 
NUMBER text box.

4 To confirm the delete, click Delete.

The following diagram shows the DELETE INVOICE NUMBER text box.

Completing Pilot Details and Passengers/Cargo/Retardant forms

The Pilot Details and Passengers/Cargo/Retardant forms display whenever 
you enter one of the following Pay Codes:

You can only enter pilot, passenger, cargo, and retardant information for the 
Pay Codes shown on this table.

To complete the Pilot Details form

1 Type the Pilot Last Name and First Name in the text boxes numbered 
“1.”  Press TAB or ENTER after completing each box.

2 Type the Co-Pilot Last Name and First Name in the text boxes 
numbered “2.”  Press TAB or ENTER after completing each box.

Pay Code Description Type of information

CN canceled flight or 
dispatch

pilot, passenger, and retardant 
information

DO mandatory day off pilot information only

ES extended standby pilot and passenger information

FT flight time pilot, passenger, cargo, and 
retardant information

GU guarantee pilot information only

ON overnight pilot information only

SB standby pilot information only
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The following diagram shows the Pilot Details form.

Once you complete the Co-Pilot’s Last Name and press TAB or ENTER, the 
Passenger/Cargo/Retardant form displays.

To enter passenger, cargo, and/or retardant information

Do not count pilots and co-pilots as passengers-crew members.

1 In the Passengers - Crew Members field, type the total number of 
passengers and crew members and press ENTER.

2 In the Cargo Type field, type the cargo type code of the cargo being 
transported for this flight leg, then press ENTER.

Valid codes are:

C all other cargo P paracargo
L long line (greater than 50 feet) S sling load (less than 50 feet).

3 In the Cargo Pounds field, type the number of pounds of cargo, 
paracargo, or sling load delivered, then press ENTER.

4 In the Retardant Type field, type the type of retardant used, then press 
ENTER.

Valid codes are:

F foam S solid-based
L liquid-based W water.

5 In the Retardant Gallons field, type the number of gallons of retardant 
delivered by the airtanker or helicopter, then press ENTER to return to the 
flight leg information block of the FLIGHT USE REPORT form.
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The following diagram shows the passenger, cargo, and retardant 
information dialog box.

Adding remarks

You can add only one set of Remarks per invoice.

To add remarks to an invoice

1 Click Remarks.

2 On the Editor dialog box, click OK.

3 Type the remarks in the space provided, and then click Exit.

The following diagram shows the Editor dialog box.

The following diagram shows the remarks text box where you can add 
remarks. 

To replace specific text in the Remarks

1 Click Remarks.

2 In the Editor dialog box, highlight the text of your choice, type the new 
text and click OK, and then click Exit on the remarks text box.
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To search forand replace specific text in the Remarks

1 Click Remarks, and then click Search on the Editor dialog box.

2 In the Search for text box, type the characters or words that you want to 
replace.

3 In the Replace with text box, type the characters or words of your choice, 
and then click Replace or Replace All.

4 When finished, click Cancel, review the remarks text box, and then click 
Exit.

The following diagram shows the Search/Replace dialog box.
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Chapter 4.  AMIS Reports

This chapter explains how to retrieve information from the database and 
generate an AMIS report that can be viewed, mailed, and printed from your 
personal computer.  Topics include:

• Accessing AMIS Reports menus
• Naming your AMIS Report
• Working with AMIS National Reports.

Accessing AMIS Reports menus
The Reports menu lists three categories of reports that you can create:

• Invoice Reports, which are generated from FLIGHT USE REPORT data

• Contract Reports, which are generated from AIRCRAFT CONTRACTS 
and AIRCRAFT INFORMATION data

• Miscellaneous Reports, which are generated from a variety of AMIS 
data.

To Do this

Access the AMIS Invoice Reports Listing On the Reports menu, click Invoice.

Access the AMIS Contract Reports Listing On the Reports menu, click Contract.

Access the AMIS Misc. Reports Listing On the Reports menu, click Miscellaneous.
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AMIS Invoice Reports Listing

To scroll up or down the AMIS Reports Listing

• Press ↑  or ↓  until the Invoice Report of your choice appears.

AMIS Contract Reports menu
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AMIS Miscellaneous Reports menu

Naming your AMIS Report
When you generate an AMIS report, it is automatically saved as a file that you 
can view in WordPad.  You can choose to keep the default file name and 
format, or choose to rename the file using one of three different formats:

• MS Word 6.0 allows you to use the features of MS Word to view, format, 
and print the file.

• Rich Text Format allows you to export to a wide variety of software 
programs.

• Text allows you to review and print from software programs that import 
“.txt” files.

To run an AMIS report of your choice

1 Access the AMIS report menu of your choice.

2 In the Enter choice text box, type the Item of your choice, and then press 
TAB or ENTER.

3 In the File Name text box, type a new file name, if desired, and then press 
TAB or ENTER.

4 For AMIS Invoice reports, complete the AMIS report parameters.  Press 
TAB or ENTER to advance to the next text box.

For more information, see the next section, “AMIS parameters for invoice 
reports.”
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5 To view the report, type Y in the View Now ? text box.

The following diagram shows a sample File Name text box, which displays a 
default file name for the “Invoice Detailed Listing by Registration.”  You can 
choose to keep the default file name or change it as desired.

The following diagram shows the AMIS reports parameters dialog box as it 
appears on the AMIS Invoice Reports Listing.
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The following diagram shows the AMIS-INVC-02 report as it displays on 
your screen.  From here, you can save or print the report as desired.

AMIS parameters for invoice reports

You can customize many AMIS Invoice reports by specifying its available 
report parameter. You can identify the report parameter by reviewing the 
Description column of the AMIS Invoice Reports Listing.  The report 
parameter is shown in ALL CAPITAL LETTERS and is enclosed by brackets.

The following fields are identified on the AMIS Report parameters dialog 
box: 

• Start Date is the first date of information to be gathered for the report.  
The default Start Date is “10/01/1999.”

• End Date is the last date of information to be gathered for the report.  The 
default End Date is “09/30/2000.”

• parameter field varies according to the report you select.  From here, you 
can type a percent sign (%) in the parameter field to include all.

• Execute?  Y/N allows you either to continue generating the report or to 
cancel the report and return the cursor to the Start Date field.

To complete the AMIS Report parameters dialog box

1 Complete the Start Date, End Date, and, if shown, the report parameter 
fields.  Press TAB or ENTER after each entry.

2 In the Execute ? field, type Y and press TAB or ENTER.
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For example, when you select the invoice report “AMIS-INVC-03,” the 
following dialog box displays.  “Regist No” is the report parameter you 
can specify for this report.  In this example, All registration numbers will 
be included in the report.

To save your report in the format of your choice

1 While reviewing the report of your choice, click Save on the File menu.

2 Click the file format button of your choice.

3 In the Save As dialog box, select the folder, file name, and file format of 
your choice, and then click Save.

The following diagram shows the dialog box that appears when you save the 
report. 

The following diagram shows the Save As dialog box.  Be sure to remember 
the file name and format so you can locate and print the report using the 
software program of your choice.
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To print a report from WordPad

1 While reviewing the report of your choice, click Print on the File menu.

2 Select the printer and print options of your choice, and then click OK.

The following diagram shows the Windows Print dialog box.

Working with AMIS National Reports
AMIS National Reports are available on the Fire and Aviation Management 
web page:

http://famweb.usda.gov

AMIS National Reports query data from NIFMID, which is located in Kansas 
City at NITC.

To access AMIS Reports from the Internet

1 Start your Internet browser. 

2 In the address box, type http://famweb.usda.gov then press ENTER.

3 Click AMIS, and then complete the Enter Network Password dialog 
box.

4 Locate the AMIS report of your choice, select the parameters of your 
choice, and then click Submit Report.

Invoice Counts by Reporting Units
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User Unit-Mission Code-Registration Summary

User Unit-Aircraft Type-Registration Summary

User-Unit-Aircraft Type-Pay Code Summary

User Unit-Aircraft Type-Mission Code Summary

User Unit-User Code-Registration Summary
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User Unit-User Code-Mission Code Summary

Aircraft Type-Mission Code Summary

Aircraft Type-Pay Code Summary

Aircraft Type-Registration Summary
October 27, 2000 version 4.3 4.9



AMIS User’s Guide Chapter 4. AMIS Reports
Retardant Base-User Unit Summary

Contract Number-Pay Code Summary

Supply Unit-Aircraft Type-Registration Summary

To submit an AMIS National Report

1 Locate the AMIS National Report of your choice.

2 For each box, type or select the appropriate value.  Press Tab to advance 
to the next box.

3 To submit the report, click the Submit button.

4 To return to the AMIS Report page, click Back on your browser’s toolbar.

The following diagram shows a completed Invoice Counts by Reporting Units 
report request for Region 2 for FY1999.
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The following diagram shows the report as displayed on your screen.
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Appendix A.  Function keys

Appendix A identifies the function keys available for AMIS.

Some keys may be unavailable when displaying a particular form.

To display a list of active function keys

• Press CTRL + F1 or click Show keys on the Help menu.

To Do This

Accept/save Press F10.

Application menu Press CTRL + ,.

Cancel Press ESC.

Clear Block Press SHIFT + F5.

Clear Form Press SHIFT + F7.

Clear Item Press CTRL + u.

Clear Record Press SHIFT + F4.

Count Query Press SHIFT + F2.

Create Record Press F6.

Debug Mode Press CTRL + ?.

Delete Backward Press BACKSPACE.

Delete Record Press SHIFT + F6.

Display Error Press SHIFT + F1.

Down Press ↓  or CTRL + l.

Duplicate Field Press F3.

Duplicate Record PRESS F4.

Edit Press CTRL + e.

Execute Query Press F8

Find Press F7.

Help Press F1.

Index Press F9.

Insert Record Press F6.

Left Press ←.

Main Menu Press CTRL + .

Next Block Press CTRL + PAGE DOWN.

Next Item Press CTRL + TAB or TAB.

Next Primary Key Press SHIFT + F3.

Previous Block Press CTRL + PAGE UP.
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To Do This

Previous Item Press SHIFT + TAB or 
SHIFT + CTRL + TAB.

Previous Menu Press CTRL + ENTER.

Previous Record Press SHIFT + ↑ .

Print Press SHIFT +  F8.

Redefine Username/Password Press CTRL + n.

Return Press ENTER.

Right Press →.

Scroll Down Press PAGE DOWN.

Scroll Up Press PAGE UP.

Show Keys Press CTRL + F1.

SQL*Menu Main Menu Press F5.

Up Press ↑  or CTRL + p.

View Right Page Press CTRL + >.
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Appendix B.  Pay Codes and invoices

The Pay Code field defines the type of use the aircraft performed for each 
flight leg of the invoice. Typically, several Pay Codes are used to describe a 
single flight.

For example, to describe the availability, actual flight time, and any extended 
standby of a single aircraft, you must use three Pay Codes:

The following chart lists the required and optional fields on the FLIGHT USE 
REPORT for each Pay Code.  Pay Codes are listed alphabetically and are 
divided into tanker (T), fixed wing (F), and helicopter (H) aircraft. 

A Remarks dialog box displays for the ``SP'' Pay Code.

Pay Code Description

AV availability

CH other charges

CN canceled flight or dispatch

CR other credit

DO mandatory day off

ES extended standby

FT flight time

GU guarantee

JC job contract

NA non-availability

NF other non-flight

ON overnight

SB standby

SP special passenger - used to track SES, Congressional, and 
other special passengers

ST service truck

TX taxes

Leg 1 + AV (availability)

Leg 2 + FT (total flight time)

Leg 3 + ES (extended standby)

$ Total of all charges
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Pay Code navigation

The following abbreviations apply for every field:

Pay 
Code

Air-
craft

Pilot 
Name

Pass. 
Crew

Carg.
Type

Carg.
Lbs.

Ret.
Type

Ret.
Gals.

Meter 
Type

Start 
Time

Stop 
Time

Lapse 
Time Rate Leg 

Total
AV T X X X X X X HCO O O R R calc

F X X X X X X HCO O O R R calc
H X X X X X X HCO O O R R calc

CH T X X X X X X X X X X R calc
F X X X X X X X X X X R calc
H X X X X X X X X X X R calc

CN T O O X X O O R R R R R calc
F O O X X X X R R R R R calc
H O O X X O O R R R R R calc

CR T X X X X X X X X X X -R calc
F X X X X X X X X X X -R calc
H X X X X X X X X X X -R calc

DO T O X X X X X X X X X X calc
F O X X X X X X X X X X null
H O X X X X X X X X X X null

ES T O X X X X X HCO O O R R null
F O X X X X X HCO O O R R calc
H O X X X X X HCO O O R R calc

FT T R O O O R R R R R R R calc
F R O O O X X R R R R R calc
H R O O O O O R R R R R calc

GU T O X X X X X HCO O O R R calc
F O X X X X X HCO O O R R calc
H O X X X X X HCO O O R R calc

JC T X X X X X X X X X X X calc
F X X X X X X X X X R R calc
H X X X X X X X X X R R calc

NA T X X X X X X HCO O O R X null
F X X X X X X HCO O O R X null
H X X X X X X HCO O O R X null

NF T X X X X X X HCO O O R R null
F X X X X X X O O O R R calc
H X X X X X X O O O R R calc

ON T O X X X X X X X X R R calc
F O X X X X X X X X R R calc
H O X X X X X X X X R R calc

SB T O OR X X X X HCO O O R R calc
F O O X X X X HCO O O R R calc
H O O X X X X HCO O O R R calc

SP T X X X X X X X X X X X null
F X X X X X X X X X X X null
H X X X X X X X X X X X null

ST T X X X X X X X X X X R calc
F X X X X X X X X X X R calc
H X X X X X X X X X X R calc

TX T X X X X X X X X X X R calc
F X X X X X X X X X X R calc
H X X X X X X X X X X R calc

Code Description Code Description

R required entry X skipped entry

-R required entry, displayed as a negative value H hardcoded entry specified by user
O optional entry C ``Clock'' specified by user.
B.2 version 4.3 October 27, 2000



Glossary

A, B
access roles.  The type of functions a user is allowed to 
perform.  The three access roles are Manager, Contract, and 
Invoice.

active, activate.  The process of including an aircraft to a 
site-specific list.

Aviation Management Information System (AMIS).  A 
comprehensive ORACLE relational database management 
system for aircraft use information for contract aircraft.  

AMIS.  See Aviation Management Information System.

AMIS user ID.  A set of letters and numbers that uniquely 
identifies a user to AMIS. 

arrow keys.  The Left Arrow, Right Arrow, Up Arrow, and 
Down Arrow keys that are used to navigate around a 
menu or form. Typically, arrow keys are located on 
the lower right-hand side of the keyboard.

block.  A portion of an ORACLE form containing a group of 
related fields.  An ordinary block displays one or more records 
whose fields are associated with the columns of a table or 
view.

C
case sensitive.  Denotes fields that accept both upper and 
lower case letters.  Records must be retrieved for update or 
delete in the same case they are initially entered.

click.  The process of choosing or selecting an option or 
command using a mouse.

column.  A part of a table that contains a specific data type.  

command.  An instruction entered in the command line of a 
form.

commit.  The process of storing new, updated, or deleted 
records from the form to a table in the database.

count.  The number of rows selected by a query.  Count is 
displayed in the lower right corner of a screen.  An asterisk 
before the count indicated the last record.  Each record 
increments the count by one.

current block.  The block where the cursor is positioned.  
Only one block at a time is considered to be current when a 
form is being run. 

current field.  The field in the current block where data is 
being entered.  Only one field may be current when a form is 
being run.

cursor.  A marker on the screen or form, such as a rectangle 
or a flashing bar, that indicates your current position.

D
data.  Raw, unorganized material used as input to a computer 
program.

database.  An organization of cross-referenced files. 

Database Administrator (DBA).  A person or persons 
assigned to oversee the management and administration of the 
database. 

DBA.  See Database Administrator.

DDB.  See Development Database.

deactivate.  The process of excluding an aircraft from a site-
specific list.

default.  Data, selection, or configuration automatically 
assigned to a field, file, or system.

delete.  An action taken to remove a given code, file, or 
record from the database.

Development Database (DDB).  The ORACLE relational 
database used to develop ORACLE software applications.

dialog box.  A pop-up window that contains various options 
and buttons for completing a particular task or field.

E, F
edit.  The process of adding, changing, or rearranging data.

FAA.  Federal Aviation Administration.

Federal Information Processing Standard (FIPS).  An 
American National Standard Institute (ANSI) system of 
uniform codes that identifies state and county names and 
codes.

field.  A set of one or more characters treated as one item of 
data.  An area used to input or display a defined type of data on 
a screen, form, or printout
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FIPS.  See Federal Information Processing Standard.  

Forest Service Database Administrator (FSDBA).  The 
ORACLE account used by Forest Service Database 
Administrators that allows access to the ORACLE database.

form.  A fill-in-the-blanks template used to enter, update, and 
delete data in the ORACLE database.  Consists of fields and 
fixed text (field names) displayed on the screen.

FSDBA.  See Forest Service Database Administrator.  

function key.  A key that is programmed to perform a 
specific function in one keystroke.

H
help.  A function that displays information about a field such 
as table name, table value (field) name, length of field, field 
entry requirements (such as mandatory, querying capability, 
etc.)  Most fields contain a hint help line and you may request 
extended help by pressing <SHIFT> + <F1>.

hierarchical.  A group of things arranged in order of rank.

horizontal scrolling.  Also called extended edit fields.  A 
feature of SQL*Forms that allows a field value to be displayed 
when the field is longer than the display length.  Denoted by a 
'>' at the end of a field.

I
IDB.  See Integrated Database.

IFR.  See Instrument Flight Rules.

information.  Data organized into a logical structure or 
sequence.

input.  The source data used as input for processing.

Instrument Flight Rules (IFR).  An aircraft is certified for 
flight in meteorological conditions.

Integrated Database (IDB).  The ORACLE database 
accessed by Forest Service production applications.

K
KCCC.  See National Computer Center - Kansas City

KCC-IBM.  See National Computer Center - Kansas City.

key field.  Usually used for access to the database.  The data 
entered into this field must be unique and is used to access 
additional information.  

keyboard.  An input device used to communicate with the 
system.

L, M
logon ID.  See AMIS user ID.

mandatory.  The field value must not be blank.

menu bar.  The menu across the top of a screen that displays 
options available for use.  The ones that are highlighted are the 
ones that are available for that particular screen or user role. 

menu option.  A choice on a menu.

menu.  A list of options.  You can select an option by clicking 
on its name on the menu.

message line.  The next to the last line, immediately above 
the status line, on a screen that displays SQL*Forms error 
messages, prompts, and other information.

multi-record block.  A block on a form that can display 
more than one record at a time.

N, O
National Computer Center - Kansas City (NCC-KC).  
The USDA national computer center in Kansas City.

NCC-KC.  National Computer Center - Kansas City.  

null.  Indicates a field that has no value.  The field is empty.  
This is not the same as a blank field or a field with zero value.

option.  Menu option.  Any choice in procedure listed on a 
WIMS menu.

ORACLE.  1)  The manufacturer of ORACLE software.  2)  
The product name for a set of related computer programs for a 
highly-sophisticated relational database.

P
password.  A set of characters defined with a user ID and 
used to secure access to computer hardware, software, and 
data.

Pay Code, payment code.  A two-character code that best 
describes the purpose of an aircraft's billing charges.

PC.  An IBM or IBM-compatible personal computer.
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Q, R
query.  The process of selecting the desired records to be 
retrieved from the database to look at or report on, or the 
commands used to perform the process.

RBAM.  See Role Based Applications and Menus.  

record.  A collection of related fields that defines a particular 
set of information.

required.  See mandatory.

Role Based Applications and Menus (RBAM).  The 
original project name for the documented application 
environment and standards.  RBAM was previously the 
acronym for Role Based Access Management.

row.  A horizontal set of fields in a table.

S
save.  To retain edited data.

screen.  A fixed group of fields that appear on the monitor at 
one time.

scroll.  To move a list of items up or down on the screen.

session.  The period of time that you are connected to AMIS.

shift key.  Key on the keyboard that when held down 
modifies a function key's operation.  For example, SHIFT + F6 
deletes a record, while F6 inserts a record.

single-record block.  A block that can display one record at 
a time.

SQL.  See Structured Query Language.

status line.  The last line on the screen that displays system 
status information.

Structured Query Language (SQL).  A relational 
database management and data retrieval language.

submit.  A function that passes a job to the computer system 
for processing.

T, U, V
table.  A named collection of related information, stored in 
the ORACLE database.  A block is associated with a table, 
although more than one table may be used per block.

update.  To change data on an existing file or record.

uppercase.  A field characteristic denoting a field in which 
lowercase letters are converted to uppercase as they are 
entered.  Most fields containing a code are converted to all 
uppercase when they display and are stored in the database.  
See also case sensitive.

user.  Any person authorized to access the AMIS system.

W
WCF aircraft.  Aircraft contracted directly from and operated 
by the USDA Forest Service.

wildcard.  A symbol, usually a percent sign (%) or an asterisk 
(*), used to symbolized all possible combinations or file 
names.
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